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A B S T R A C T   

Nile tilapia (Oreochromis niloticus) skin is a well-known biomaterial used as an occlusive dressing for burn 
treatment. It is also an inexpensive and important source of collagen. This study aims to describe the ultra
structural aspects of Nile tilapia skin, assess its collagen amount and organization, and compare quantitative 
methods of histochemical and immunohistochemical analysis (in all sterilization steps for use in burn dressings). 
One sample (0.5 × 0.5 cm) of ten different fish skins was divided in four groups: in natura skin (IN), chemical 
sterilization (CH), additional irradiation (30 kGy) (IR), and skins used in burn treatment (BT) to compare his
tochemical and immunohistochemical findings of collagen amount and describe ultrastructural aspects through 
scanning electron microscopy. The amount of type I collagen decreased during sterilization and clinical use 
owing to gradual reduction of immunostaining (anti-collagen-I) and decreasing fiber thickness of the collagen, 
when compared to type III (Picrosirius-red-polarized light). The collagen fibers were rearranged at each steril
ization step, with a low collagen percentage and large structural disorganization in BT. The amount of type-I 
collagen was further reduced after BT (p < 0.05). Both the methods did not exhibit a quantified value differ
ence (p = 0.247), and a positive correlation (r = 0.927; 95 % CI = 0.720–0.983) was observed between them, 
with concordance for collagen quantification in similar samples, presenting a low systematic error rate (Dalberg 
coefficient: 6.70). A significant amount of type-I collagen is still observed despite sterilization, although clinical 
application further reduces type I collagen. Its quantification can be performed both by immunohistochemistry 
and/or Picrosirius Red reliably.   

1. Introduction 

Collagen, as a primary component of the extracellular matrix, plays 
an important role in maintaining its biological and structural integrity. 
This molecule has a triple-helix structure (Cen et al., 2008), with more 
than 29 different types described. Type I collagen (COL-I) is most 
commonly found in humans in the bone, skin, teeth, fibrocartilage, and 
tendons and has the unique ability to form highly-resistant fibrils 

(Gómes-Guillén et al., 2011). The chemical composition and structure of 
this extracellular matrix component enables numerous applications, 
specifically in the composition of biomaterials used in tissue engineer
ing. COL-I has been used in numerous applications, such as drug de
livery, skin substitutes, suturing, and tissue engineering substrates (Tang 
and Saito, 2015). 

The development of biomaterials, mostly containing collagen as the 
main constituent, has gained considerable support because it improves 
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their biocompatibility. Therefore, collagen is used widely in different 
presentations as biological dressings, even in association with other 
products and regenerative techniques, most of which are heterogenous 
biomaterials of porcine or bovine origin (Guo et al., 2016; Mathangi 
et al., 2013; Norbury et al., 2016). 

However, zoonotic infectious diseases and allergic problems may be 
considered when using bovine or porcine collagen. In addition, there are 
some religious restrictions in many countries on the application of 
certain mammalian isolates (Sun et al., 2017; Tang and Saito, 2015). 
Therefore, other sources of COL-I must be explored. In this context, 
tilapia skin has been studied, which could be an alternative source of 
collagen in addition to those already recommended. 

Yamamoto et al. (2014) showed that COL-I extracted and purified 
from tilapia fish scales is easily adsorbed than bovine and porcine 
collagen (Yamamoto et al., 2014). Because of this effect, tilapia fish 
COL-I has gained popularity in the cosmetic industry (Tang and Saito, 
2015) and has been described as a safe substance without adverse skin 
reactions following intracutaneous and topical application (Yamamoto 
et al., 2014). Furthermore, Matsumoto et al. (2015) demonstrated that 
tilapia fish COL-I is superior to porcine skin COL-I in inducing human 
mesenchymal stem cell differentiation (Matsumoto et al., 2015). 

In addition, our group showed that tilapia skin has satisfactory his
tological and mechanical properties, consistent with those of human 
skin, which justifies the scientific investments in using it as a biomaterial 
(Alves et al., 2015, 2018). 

Nile tilapia (Oreochromis niloticus) belongs to the Cichlid family and 
originates from the Nile basin in East Africa. This fish is found in the 
tropical and subtropical regions of the world. In particular, it is abun
dantly found in the state of Ceara, where it is an important commercial 
product because of its availability and low cost. It is known for its meat 
quality and mild taste and is an important product in regional 
gastronomy (Alves et al., 2015; Franco et al., 2013; Lineen and Namias, 
2008). 

In Ceara, there is a heavy consumption of Nile tilapia fish generating 
by-products, such as skin, intended for disposal. After the Ethics Com
mittee approval, burns were treated successfully using tilapia skin as an 
occlusive dressing, which has gained worldwide attention (Lima Júnior 
et al., 2020, 2021). It allows tissue repair and serves as a physical barrier 
in addition to preventing dehydration, sepsis, and metabolic and func
tional complications (Boateng and Catanzano, 2015; Inoue et al., 2016; 
Lineen and Namias, 2008). The use of tilapia skin has transcended its 
application in burns and is also used in other soft tissue reconstructive 
surgeries, such as neovaginoplasty (Bezerra et al., 2018; Dias et al., 
2020; Pinto Medeiros Dias et al., 2019) and male-to-female gender-
affirming surgery (Rodríguez et al., 2020). 

In tissue engineering, the discovery of products with promising 
properties often occurs empirically; for example, the amniotic tissues, 
which were first used in 1938 (Rötth De, 1940) in reconstructive eye 
surgery. Currently, the amniotic membrane is widely used in several 
medical fields, including burn treatment (Clare et al., 2012). 

Currently, knowledge regarding the histological and micromorpho
logical aspects of this naturally-derived biomaterial is limited (Lima-
Verde et al., 2020). Therefore, this study aims at describing the 
ultrastructural aspects of Nile tilapia skin, assess its collagen amount and 
organization, and compare quantitative methods of histochemical and 
immunohistochemical analysis (in all sterilization steps for use in burn 
dressings). 

2. Material and methods 

2.1. Sample gathering, sterilization protocol, and study groups 

Nile tilapia (Oreochromis niloticus) skin samples were obtained from 
fish farms in Castanhão (Jaguaribara-CE). Fish are raised and sacrificed 
at approximately 800–1000 g, through stunning by thermal shock and 
subsequent bleeding. The skins were removed, cleaned, and cut in a 

standardized manner for further processing. 
For this study, 10 different fish skins were used with four groups 

established according to the evaluation phase (stages of the sterilization 
process or clinical application) (Fig. 1). 

In the natura skin group (IN), samples were cleaned only with saline 
solution (natural fish skin). In the chemical sterilization (CH) group, 
skins were subjected to successive 30-minute baths in 2 % chlorhexidine. 
Sequentially, they were subjected to three baths in glycerol with cres
cent concentrations (50 %, 75 %, and 99 %), followed by 1% penicillin/ 
streptomycin/fungizone; each step lasted 5 min. In irradiation group 
(IR), skins were, at first, individually packaged into double plastic 
(hermetically sealed) envelopes and submitted to additional sterilization 
by radiation (30 kGy) (Alves et al., 2018). 

Irradiated Tilapia skins were stored under refrigeration (2–8 ◦C) until 
their clinical use for burn care in four different participants of a phase II 
randomized controlled trial (Lima Júnior et al., 2020). Prior to dressing 
application, rehydration was performed in a saline solution. After 
treatment was completed (approximately 15–21 days, depending on 
each patient’s healing response and the extent of the wound), the skin 
that was in close contact with the wound was collected for analysis, 
comprising the last study group (BT) (case-control ratio = 2:1). 

All collected samples (0.5 × 0.5 cm) were fixed in 10 % formalde
hyde (pH = 7.4) or 0.05 M cacodylate buffer + 2.5 % glutaraldehyde + 4 
% formaldehyde solution for optical and scanning electron microscopy, 
respectively. 

2.2. Histochemical analysis – picrosirius red 

Paraffin blocks were prepared by semi-automatic histological pro
cessing (LupeTec®, PT05) of 10 % formalin-fixed skins. After microtomy 
(4 μm), (Leica Microsystems®, RM2235) microscopic slides were 
deparaffinized, dehydrated, and stained by the conventional hematox
ylin & eosin (H&E) method for histological analysis of sample cutting 
and representativity. Subsequently, new sections were submitted to 
Picrosirius Red’s histochemical reaction (Easypath®) according to the 
manufacturer’s instructions. 

Histochemical reactions were performed with 3 μm paraffin block 
slices, using Picrosirius Red staining, and the collagen content of the skin 
samples was analyzed and typified in collagen I (yellowish-red
birefringence) and III (whitish-green birefringence), through light po
larization (Leica DM 2000), as described in previous studies (Alves et al., 
2018, 2015; Yuan et al., 2011). 

Photomicrographs of three microscopic fields were captured (Leica 
Microsystems®, DFC295) from each sample at 400× magnification 
(comprising the entire length of the sample). The collagen I percentage 
was calculated using the color threshold command (Image > Adjust >
Color Threshold) in ImageJ® software, regulating red and green colors 
on RGB color channels. By selecting the area of interest and isolating 
COL-I, the image was binarized (Process > Binary > Make Binary) and 
the fractional area percentage was calculated (Analyze > Analyze Par
ticles). Thus, the COL-I percentage was calculated based on the per
centage of total collagen in each photomicrograph (quantified without 
color threshold command) (Alves et al., 2018). The average of the three 
fields was considered as the sample unit. 

2.3. Immunohistochemical analysis 

Immunohistochemical reactions were performed with 3 μm paraffin 
block slices using the streptavidin-biotinylated technique (Hsu et al., 
1981). Antigenic recuperation was performed by heating in citrate so
lution (pH 6.0), followed by incubation with a primary antibody for 
COL-I (ab23730, 1:500, overnight). Tuna skin was used as a positive 
control, while the negative control was the suppression of the primary 
antibody. The immunostained areas were visualized using the Universal 
Immune-peroxidase Polymer (Histofine®, for Abcam® primary anti
bodies; 30 min), followed by DAB (5,5-diaminobenzidine 

M.E.Q. Lima Verde et al.                                                                                                                                                                                                                      



Acta Histochemica 123 (2021) 151762

3

tetrahydrochloride) and Harris’ hematoxylin counterstaining. Entellan® 
was used as the mounting medium for all slides. 

For microscopic evaluation (Leica Microsystems®, DM2000), pho
tomicrographs of three microscopic fields were taken (Leica Micro
systems®, DFC295) from each sample at 400x magnification 
(comprising the entire length of the sample). The marked area per
centage was calculated by the color deconvolution command (Plugins >
Color Function > Color Deconvolution) using ImageJ® software, by 
selecting DAB + Hematoxylin option (H DAB), and using color stratifi
cation compatible with DAB marking. Thus, the image was binarized 
(Process > Binary > Make Binary), and the fractional area percentage 
was calculated (Analyze > Analyze Particles). The COL-I percentage was 
calculated based on the percentage of the total area in each photomi
crograph (quantified without deconvolution command), considering the 
average of the three fields as sample units (Zhou et al., 2015). 

2.4. Scanning electron microscopy (SEM) analysis 

Samples fixed in 2.5 % glutaraldehyde, 4 % formaldehyde, and 0.05 
M sodium cacodylate buffer solution were washed three times with 0.05 
M sodium cacodylate buffer, dehydrated in an acetone series, and crit
ical point dried. After mounting in stubs, the samples were sputter 
covered with gold (Quorum QT-ES) for observation under a scanning 
electron microscope (Quanta® 450 FEG-FEI) for structural and 
descriptive analysis of collagen. One representative image of each group 
was performed at 2500× and 80000× magnification after analysis to 
allow visualization of the collagen fiber structure and its possible al
terations. The analysis was performed at 20 kV. 

2.5. Statistical analysis 

Quantitative data were expressed as mean and standard error, sub
mitted to the Kolmogorov–Smirnov normality test, and compared using 
paired Student’s t-test for comparison between two evaluation methods 
(histochemical and immunohistochemical). In addition, measurements 
were validated using Pearson’s correlation and Dahlberg’s random 
systematic error measurement analysis through the calculation of 
interclass agreement coefficient. ANOVA/Bonferroni was employed for 
comparison between different groups (parametric data) (SPSS 20.0, p <
0.05). 

3. Results 

3.1. Histochemical and immunohistochemical descriptive analyses 

The amount of type I collagen decreased during sterilization and 
clinical use owing to a gradual reduction in immunostaining (Fig. 2A, C, 
E, G) and decreasing fiber thickness (Fig. 2B, D, F, H) of the collagen, 

compared to the thickness of type III collagen fibers. In natura skin (IN) 
samples confirmed the morphological findings of previous studies per
formed by this group, showing the preservation of the collagen fiber 
morphology, with parallel and vertex shape disposition, and now 
evidencing an abundance of type I collagen (Fig. 2A and B), as shown by 
immunohistochemical staining and Picrosirius Red staining methods. 

In contrast, the CH group showed a homogeneous decrease in im
munostaining for type I collagen throughout the samples (Fig. 2C). In 
parallel, disorganization of the collagen fiber arrangement can be 
observed using both methods. Picrosirius Red, in turn, discriminates this 
disorganization by showing a decrease in the thickness of type I collagen 
fibers, when compared to type III collagen fibers (Fig. 2D). 

After irradiation (IR group), tilapia skin samples exhibited a rees
tablishment of immunostaining for type I collagen, as well as a reorga
nization of collagen fibers (Fig. 2E), which can be exemplified by the 
restructuring of the thickness of these structures when compared to type 
III collagen fibers (Fig. 2F). 

After clinical application of burn treatment (BT), skin samples did 
not undergo the same changes observed after chemical sterilization. 
Although no morphological disorganization of the fibers was observed, 
the immunostaining for type I collagen (Fig. 2G) and fiber thickness 
(observed by Picrosirius Red) (Fig. 2H) exhibited a prominent reduction. 
Residual inflammatory cells were also observed in these samples. 

Both optical and electron microscopy observations showed an 
apparent rearrangement of collagen fibers at each sterilization step 
(Figs. 2 and 6). 

3.2. Collagen quantification and correlation between methods 

In both methods (immunohistochemical staining for anti-collagen I 
and Picrosirius Red histochemical reaction), there was a decrease in the 
amount of COL-I during sterilization and after clinical application. The 
IN skin (74.53 ± 1.47) presented a higher amount of COL-1 than CH, IR, 
and BT (p < 0.05). In addition, CH (63.08 ± 3.73) and IR (63.05 ± 2.07), 
despite being associated with a decrease in the amount of collagen 
compared to IN, present higher values in relation to BT (43.61 ± 1.49). 
This reinforces that factors related to clinical application likely interfere 
with the amount of COL-1 (p < 0.005) (Fig. 3). 

Comparing the collagen values obtained between the COL-I immu
nohistochemistry technique and the histochemical staining of polarized 
Picrosirius for reddish yellow birefringence (suggestive of COL-I), no 
differences were found in the quantified values (p = 0.247/Student`s t 
test). Thus, both techniques were equally effective in identifying this 
type of collagen (Fig. 4). 

In the error measurement analysis, the two methodologies were 
compared in different samples, and they were able to identify similar 
amounts of collagen, without differences between them (r = 0.927, ICC 
= 0.938). In linear regression, a large proximity was observed between 

Fig. 1. Flowchart describing number of skins used in each of the four groups, according to evaluation phase.  
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the points and the midline, by analyzing the correspondence between 
the two techniques in the different samples, with a low systematic error 
index (Dalberg’s coefficient: 6.70) (Fig. 5). 

3.3. SEM analysis 

Structural and descriptive analysis of collagen revealed a sample (IN) 
composed in large part by the presence of a well-preserved fibrillar 
collagen structure (Fig. 6A). 

The results of the methodologies using optical microscopy were 
validated by SEM analysis, because it was possible to perceive the 
presence of collagen fibrillar structure with overlap of material 

suggestive of chemical substance in CH group. Moreover, the helical 
structure that characterizes the collagen fibers was less evident (Fig. 6B). 

After rehydration, the sterilization process was enhanced by addi
tional irradiation (IR), leaving the sample free of any impurity and 
preserving the fibrillar structure of collagen by eliminating the debris 
(Fig. 6C), despite the modifications observed by optical microscopy. 

Finally, the inflammatory process that characterizes the lesions to 
which this skin is intended for clinical use (BT) had a direct impact on 
the integrity of type I collagen fibers (evidenced by optical and electron 
microscopy). The SEM analysis results showed both the partial degra
dation of these fibers and presence of organic material and cellular 
content, including cell structures likely originated from the surgical 

Fig. 2. Microscopical features of tilapia in 
natura skin (IN), after chemical (CH) and addi
tional radiation (IR) sterilization, and after 
clinical use (BT) samples under immunohisto
chemical (IHC) and histochemical (Picrosirius 
Red) – polarized light – techniques perspective 
(400x), showing a reduction in the amount of 
type I collagen, during the steps of sterilization 
and clinical use, as observed in reducing im
munostaining (A, C, E, G) and decreasing fiber 
thickness (B, D, F, H) of type I collagen (yellow 
arrows) compared to the thickness of type III 
collagen fibers (white arrows). Bars: 50 μm.   
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wound and by interspersion of the collagen fiber network. Most parts of 
the cell structures are still preserved (Fig. 6D). 

4. Discussion 

Morphological observation of tilapia skin collagen after different 
steps of the sterilization protocol and clinical use and its quantification 
(total and in type I and III) using different methods (immunohisto
chemistry and Picrosirius-Red) reinforced the potential of this byprod
uct as an abundant source of COL-I and raw material for tissue 
engineering. 

Collagen constitutes approximately 30 % of the total protein content 
of animals. This protein accounts for triple-helix structures consisting of 
nearly identical polypeptide chains (Sell et al., 2009), which offers them 
with great tensile strength and thermal stability (Mogilner et al., 2002), 
thereby showing its potential use as a raw material for different clinical 
products. 

The dermis structure, which is the primary constituent of the integ
ument, has approximately 80 % of its dry weight composed of COL-I. It 
exists in the form of loosely interwoven, large, wavy, randomly oriented 

bundles, and provides skin protection and resistance properties (Waller 
and Maibach, 2006). Recently, this collagen has been preferentially used 
in regenerative medicine because of its predominance in the extracel
lular matrix. Therefore, it has high biocompatibility, low antigenicity, 
and can be extracted by different methods, using chemical and enzy
matic processes (Song et al., 2019). 

Collagen fibers have excellent tensile strength and thermal stability 
because of their three left-handed helices supercoiled right-handed 
around a common axis, constituting the triple helix structure (Mogil
ner et al., 2002). Nile tilapia has been studied for its potential use in 
biomaterials. Acid-soluble and pepsin-soluble collagen extracted from 
Nile tilapia skin have typical COL-I characteristics (Kittiphattanabawon 
et al., 2019). 

Tilapia skin is a COL-I-rich biomaterial and the amount of this 
important component depends on the processing steps of the biomaterial 
(Mogilner et al., 2002) 

In our study, however, tilapia skins were analyzed at different stages 
of sterilization and after their clinical application. This analysis revealed 
a decline in COL-1 levels after the skin underwent irradiation and 
chemical sterilization, as well as a remarkable reduction after clinical 
use. 

This reduction is caused by the action of inflammatory cells in the 
wound bed. Inflammatory wound parameters in tilapia skin treatment 
were evaluated in previous experimental studies, demonstrating a mild- 
to-moderate mononuclear inflammatory phenotype in tilapia skin- 
covered wounds, which positively influenced the healing process, 
compared to the control group (in which acute inflammatory reactions 
were evidenced) (Lima-junior et al., 2017). 

Despite all the inflammatory infiltrates, the collagen of tilapia skin 
was not completely damaged; superficial layers were maintained, which 
guaranteed the permanence of the occlusive dressing until complete 
healing of the patient’s skin (Lima Júnior et al., 2020). 

Thus, tilapia skin exerts a protective effect on the wound beyond the 
biological buffer and the water content reduction, and acute inflam
matory reactions were softened in the wound bed and directed to the 
dressing (which, because of COL-1 abundance, was degraded by the 
inflammatory action, as observed in other conditions) (Kotaniemi et al., 
2003). 

This study also revealed that the Picrosirius-Red histochemical 
technique demonstrated a similar sensitivity, when compared with the 
immunohistochemical technique, in detecting COL-I in different tilapia 
skin substrates. 

Fig. 3. Quantification and comparison of COL-1 amount between groups, 
showing that IN samples present a higher amount when compared to other 
groups. Additionally, burn treatment seems to further reduce COL-1 amount (p 
= 0.247/ANOVA/Bonferroni). Caption: IN: in natura; CH: chemical sterilized; 
IR: irradiated group; BT: burn treatment group. 

Fig. 4. Quantification of COL-I by immunohistochemical (IHC) and histo
chemical (Picrosirius Red) techniques (p = 0.247/Student’s t test) for collagen 
quantification. 

Fig. 5. Correlation plot for COL-I detection between histochemical (Picrosirius 
Red) and immunohistochemical (IHC) techniques in in natura skin (IN), after 
chemical (CH) and additional radiation (IR) sterilization, and after clinical use 
(BT) samples. Positive correlation (r = 0.927; 95 % CI = 0.720 to 0.983) could 
be observed between the two techniques performed, with cordage for collagen 
quantification in similar samples, presenting low systematic error rate (Dalberg 
coefficient: 6.70). 
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The different types of collagen have been visualized using various 
techniques. Scanning and transmission electron microscopy offer high- 
resolution visualization of individual collagen fibers but are expensive, 
involve complicated specimen preparation, and offer nanoscale detail 
that is excessive for many applications and do not differentiate the 
collagen (Starborg et al., 2013). In addition, second harmonic genera
tion imaging is sensitive, specific for fibrillar collagen, and compatible 
with automated quantification methods but is relatively expensive as it 
requires multiphoton microscopy (Drifka et al., 2016). 

Histochemical dyes, such as Picrosirius Red, are resistant to fading, 
are inexpensive, and provide reproducible staining (Junqueira et al., 
1979). The Picrosirius staining method relies on the elongated, anionic 
structure of the Sirius red dye molecule, which binds parallel to cationic 
collagen fibers. This staining, under linear polarized light, enhances the 
natural birefringence of collagen bundles, which are revealed as red, 
orange, yellow, or green fibers. One limitation of this technique is that 
sample orientation under linearly polarized light substantially affects 
the Picrosirius hue and signal strength (Borges et al., 2005; Wegner 
et al., 2017). 

The Picrosirius staining is a cheaper technique with the same ability 
to detect collagen, such as immunohistochemistry (Vogel et al., 2015). 
Lattouf et al. (2014) used both techniques for detecting type III collagen 
on different normal and pathological tissue substrates and suggested 
that the picrosirius polarization method is simple, sensitive, and specific 
for collagen staining (Lattouf et al., 2014). It is useful to reveal the 
molecular order, organization, and/or heterogeneity of collagen fiber 
orientation in different connective tissues. For this, however, the author 
compared only the raw values found in both techniques and a descrip
tive analysis of regions stained by immunohistochemistry and green 
refringence in Picrosirius. Therefore, a quantitative study is essential to 
validate the correlation of these analyses and comparatively evaluate 
their applicability in a more reliable manner. 

To date, only one study, per our knowledge, recently published in 
2017 reveals that Picrosirius red has similarity with Fluorescence 
staining and immunohistochemistry for different types of collagen by 
quantitative analysis (without performing statistical correlation analysis 
between methods). This study also suggests that each subtract should 
have its properties previously analyzed to use the Picrosirius technique 
as a safe tool for collagen quantification, as performed in the present 

study for tilapia skin (Wegner et al., 2017). 
The literature shows conflicting results regarding different sterili

zation methods and modification of collagen properties in different ex
tracts. Alomar et al. (2012) suggested that low chlorhexidine 
concentrations up to 2% did not alter the organizing properties of 
collagen or its mechanical characteristics in tendon-derived grafts based 
on large amounts of collagen; however, the same author stated that these 
characteristics could be modified at higher concentrations (4 %) (Alo
mar et al., 2012). Other studies analyzing the effect of various chemical 
protocols, including ethylene and peracetic acid, suggested that this type 
of sterilization could result in residue impregnation and collagen 
cross-link alteration (Faraj et al., 2011). 

Delgado et al. (2014) demonstrated that chemical graft sterilization 
demonstrates the lower agglomeration of collagen fibers when 
compared to other techniques, a structural characteristic that may in
fluence their mechanical properties. 

In our study, skins submitted to chemical sterilization obtained 
smaller amounts of type I collagen and presented more disorganized 
fibers. Electron microscopy confirmed that the fibers also presented a 
large amount of material overlapping the fibrils, probably residual to the 
chemical process. 

There are few noteworthy studies with chlorhexidine protocols 
similar to those performed in the present study, such as collagen type 
quantification. In addition, the literature indicates that different sub
strates respond differently to sterilization protocols, and prior analysis is 
important to select the best form for each biomaterial. 

Regarding irradiation sterilization, it was evidenced in the present 
study that this mechanism resulted in smaller amounts of type I collagen 
and thinner fibrils in relation to fresh skin, but these characteristics were 
superior to chemically sterilized skin. 

Irradiation at extremely low or high doses causes change in collagen 
organization, such as increased degradation and severe loss of cross- 
linking (Barth et al., 2011). However, intermediate doses (20–35 kGy) 
increase fiber condensation but do not interfere with mechanical prop
erties (Delgado et al., 2014). 

Therefore, the dose used in the present study, which was established 
in the previous studies of the same study group, provides improvement 
in collagen condensation (detected by higher type I collagen labeling) 
and removal of debris remaining during chemical sterilization, thereby 

Fig. 6. Scanning electron microscopy of tilapia skin samples, showing the clear striated structure of collagen fibers (white arrows) in IN (A) and IR (C) samples, while 
CH (B) and BT (D) samples present areas suggestive of chemical or organic (red arrows) substances overlapping, respectively. Bars – 1 μm. 

M.E.Q. Lima Verde et al.                                                                                                                                                                                                                      



Acta Histochemica 123 (2021) 151762

7

showing better characteristics as described in the SEM, where the irra
diated skin was cleaner and had more organized fibrils. 

5. Conclusions 

Tilapia skin can be an important source of collagen, particularly 
COL-I, with no negative influence on the ultrastructural and morpho
logical aspects of the sterilization protocol. After being used in burn 
treatment, tilapia skins exhibit structural disorganization and lower 
collagen content. 

Immunohistochemistry and Picrosirius Red are two methods that can 
be used for collagen detection, and quantification using both methods 
has equal reliability. 
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2013. Comparação das peles de tilápia do Nilo, PACU e Tambaqui: Histologia, 
composição e resistência. Arch. Zootec. 62, 21–32. https://doi.org/10.4321/S0004- 
05922013000100003. 
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Diógenes, A.K.L., Neves, K.R.T., do Uchôa, A.M.N., do Soares, M.F.A.N., de 
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Lima-junior, E.M., Picollo, N.S., José, M., De Miranda, B., Lyeverton, W., Ribeiro, C., 
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L., de Moraes, M.O., de Paulo Aragão Sabóia, V., Bertassoni, L.E., Alves, A.P.N.N., 
2020. Nile tilapia fish skin, scales, and spine as naturally derived biomaterials for 
tissue regeneration. Curr. Oral Health Rep. 7, 335–343. https://doi.org/10.1007/ 
s40496-020-00286-y. 

Lineen, E., Namias, N., 2008. Biologic dressing in burns. J. Craniofac. Surg. 19, 923–928. 
https://doi.org/10.1097/SCS.0b013e318175b5ab. 

M.E.Q. Lima Verde et al.                                                                                                                                                                                                                      

https://doi.org/10.1177/0363546512443808
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0010
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0010
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0010
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0010
https://doi.org/10.1007/s10561-017-9681-y
https://doi.org/10.1007/s10561-017-9681-y
https://doi.org/10.1016/j.biomaterials.2011.08.013
https://doi.org/10.1016/j.biomaterials.2011.08.013
https://doi.org/10.20513/2447-6595.2018v58n2p6-8
https://doi.org/10.20513/2447-6595.2018v58n2p6-8
https://doi.org/10.1002/jps.24610
https://doi.org/10.1002/jps.24610
https://doi.org/10.1007/s00441-005-1108-6
https://doi.org/10.1007/s00441-005-1108-6
https://doi.org/10.1203/PDR.0b013e31816c5bc3
https://doi.org/10.1002/14651858.CD009379.pub2
https://doi.org/10.1002/14651858.CD009379.pub2
https://doi.org/10.1586/17434440.2014.900436
https://doi.org/10.1016/j.jmig.2019.09.779
https://doi.org/10.1016/j.jmig.2019.09.779
https://doi.org/10.1369/0022155416659249
https://doi.org/10.1369/0022155416659249
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0065
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0065
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0065
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0065
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0065
https://doi.org/10.4321/S0004-05922013000100003
https://doi.org/10.4321/S0004-05922013000100003
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0075
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0075
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0075
https://doi.org/10.1016/j.burns.2015.10.018
https://doi.org/10.1016/j.burns.2015.10.018
https://doi.org/10.1177/29.4.6166661
https://doi.org/10.1177/29.4.6166661
https://doi.org/10.1111/1346-8138.13276
https://doi.org/10.1007/BF01002772
https://doi.org/10.9755/ejfa.2019.v31.i2.1911
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0105
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0105
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0105
https://doi.org/10.1369/0022155414545787
https://doi.org/10.1369/0022155414545787
https://doi.org/10.1093/jbcr/irz205
https://doi.org/10.1097/PRS.0000000000007895
https://doi.org/10.1097/PRS.0000000000007895
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0125
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0125
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0125
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0125
http://refhub.elsevier.com/S0065-1281(21)00084-2/sbref0125
https://doi.org/10.1007/s40496-020-00286-y
https://doi.org/10.1007/s40496-020-00286-y
https://doi.org/10.1097/SCS.0b013e318175b5ab


Acta Histochemica 123 (2021) 151762

8

Mathangi, R.K., Babu, M., Mathivanan, J.V., Shankar, K., 2013. Advantages of collagen 
based biological dressings in the management of superficial and superficial partial 
thickness burns in children. Ann Burn. Fire Disasters 26, 98–104. 

Matsumoto, R., Uemura, T., Xu, Z., Yamaguchi, I., Ikoma, T., Tanaka, J., 2015. Rapid 
oriented fibril formation of fish scale collagen facilitates early osteoblastic 
differentiation of human mesenchymal stem cells. J. Biomed. Mater. Res. - Part A 
103, 2531–2539. https://doi.org/10.1002/jbm.a.35387. 

Mogilner, I.G., Ruderman, G., Grigera, J.R., 2002. Collagen stability, hydration and 
native state. J. Mol. Graph. Model. 21, 209–213. 

Norbury, W., Herndon, D.N., Tanksley, J., Jeschke, M.G., Finnerty, C.C., 2016. Infection 
in burns. Surg. Infect. (Larchmt) 17, 250–255. https://doi.org/10.1089/ 
sur.2013.134. 

Pinto Medeiros Dias, M.T., Lima Júnior, E.M., Negreiros Nunes Alves, A.P., Monteiro 
Bilhar, A.P., Rios, L.C., Costa, B.A., Rocha Matos, E.S., Venancio, A.C., Bruno, Z.V., 
Odorico de Moraes Filho, M., Pinheiro Sobreira Bezerra, L.R., 2019. Tilapia fish skin 
as a new biologic graft for neovaginoplasty in Mayer-Rokitansky-Kuster-Hauser 
syndrome: a video case report. Fertil. Steril. 112, 174–176. https://doi.org/10.1016/ 
j.fertnstert.2019.04.003. 
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